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Prerequisites 
 

The prerequisite for this tutorial is having worked through the SAAM II 
introductory tutorial, “Getting Started with SAAM II Compartmental.” It is 
recommended that you have worked through the SAAM II tutorial “Saving and 
Restoring Solutions.” 

 
What you will learn in this tutorial 
 
The purpose of this tutorial is to show you how to how to create delays in your 
compartment model. You will learn 
 

• How to use the Delay tool in the Model Toolbox to create a delay (Part 1). 
• How to use the Delay tool in the Model Toolbox to create a delay with split 

output (Part 2). 
• How to create absolute delays (Part 3) 

 
Files Required 
 

Study Files: The study files for this tutorial are 
 

delay1.stu 
delay2.stu 
delay3.stu 

 
These file are included as part of this tutorial for convenience; you will actually 
create these study files are part of the tutorial.  
 
Data files: The data files for this tutorial are 
 

delay1.dat 
delay3.dat 

 
 

Introduction 
 
This tutorial focuses on how to create delays in your compartment model. In the SAAM 
II Compartmental application, there are two ways delays can be created. One way is to 
use the Delay tool in the SAAM II Toolbox. The other way is to use a mathematical 
function called the Heaviside function. The latter is an advanced modeling technique that 
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should be used only in specific instances when a nearly absolute delay is required; it is 
discussed in Part 3. 
 
The Delay tool in the SAAM II Compartmental application creates delays 
automatically as a series of compartments. The larger the number of compartments 
specified for the delay in the Delay Attributes dialog box, the closer the delay will be to 
a true (absolute) delay, but the longer the computation time may be. The number of 
compartments in the delay is set by the user. The delay time can be either fixed, when the 
attributes associated with the delay are defined, or can be defined as a parameter that can 
be either fixed or adjustable.  
 
Delays are usually required to describe physiological processes such as absorption, 
uptake across cell membranes, or amino acid incorporation into proteins. The situation 
can be represented schematically as follows: 
 

 

delay

input sample

 
 
 
 
 
 
 
 
There is an input “upstream” from where the experimental samples are taken. The delay 
is required when there is an actual delay in the appearance of the test substance in the 
compartment from which samples are taken. The delay usually represents a composite of 
metabolic activity, the details of which cannot be described from the actual data. This is 
why, in most instances, delays represented by a series of compartments is appropriate. 
 
The situation above is one where the delay is between the input and the sample site. 
There are instances where material from the delay may actually pass to several 
compartments. An example would be the measurement of amino acid incorporation into 
several proteins. The situation for two outputs can be diagrammed as follows: 
 

delay

input

sample

sample

 
 
In this case, information on the split output must be provided; this is discussed in Part 2. 
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Delays implemented by a string of compartments actually represent a transfer function 
corresponding to a probability distribution function. The distribution function has a mean 
and a variance (standard deviation). The mean is the delay time, and the standard 
deviation is the delay width which is a measure of the “sharpness” of the delay. The 
transfer rate constant between compartments in the delay equals the number of 
compartments in the delay divided by the delay time. 
 
What does this mean? The Delay Attributes dialog box associated with a delay in SAAM 
II appears as follows: 
 

 
 
In this case, the delay number is “3”. The default values for the delay time and the 
number of compartments in the delay are 1.0 and 2 respectively. Normally, as illustrated 
in this tutorial, the delay time is set equal to a parameter. 
 
Consider the following example: 
 

 
 
This could illustrate the first steps of absorption where Compartment 1 could be the 
stomach and Delay 2 could be the gut. If the number of compartments in the delay were 
set equal to 5, internally the model would appear: 
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while if the number were set equal to 10, the model internally would appear: 
 

 
What is the difference, and what is the relationship between the delay time specified as 
part of the delay attribute, and the actual delay time that is desired? That is, the “delay 
time” as the transfer function mean, and the “delay time” actually required by the data 
may be different. This is a function of how a delay as a string of compartments work. 
 
Consider an experiment on these two models where a bolus of “100” is given respectively 
into Compartments 1 and 11. Suppose k(2,1)=k(12,11)=0.05, and the delay time is 150. 
Then for a the five compartment delay, the transfer rate constant equals 5/150, or .033 
while for the 10 compartment delay, this is 10/150, or .0667. This is shown in the 
following figure: 
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The actual delay is created by the material leaving the last compartment in the delay, q6 
and q21 respectively. 
 
For the five compartment delay, s1 is the total mass in the delay as a function of time 
while s2 is the amount in Compartment q6; it is this amount that will appear in the next 
compartment of interest in your model. A plot of the two is shown in the following 
figure: 
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You can see that s1 has a slightly skewed distribution with a mean around 150. You can 
also see that material starts to appear from Compartment q6 (measured by s2) at around 
30 minutes. Thus the “physiological” delay is about 30 minutes. The counterparts for the 
10 compartment delay are shown in the following figure: 
 

Rev. 11/01/05 DelaysUS-6 2004 - 2005 University of Washington 



Using SAAM II Using Delays 

 
 
You can see the mean of the delay is again at 150, but now the width is smaller (as shown 
in the following figure). Material starts to appear from the last compartment in the delay 
(s4) at about 50 minutes. 
 
Comparing the mass in the delay: 
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The 10 compartment delay, s3, has a slightly narrower distribution. Of interest is the 
effect on the “physiological” delay as shown in the following figure: 
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The difference in the appearance of material from the last compartment in the delay 
between the 5 and 10 compartment delay is quite dramatic. 
 
In this tutorial, you will explore these phenomena in more detail so that you can better 
appreciate the nature of a string of compartments as a delay tool, and know better how to 
select the number of compartments. 
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Part 1. Working with the delay tool – Single output from the delay 
 
In this part of the tutorial, you will create and work with the following model: 
 

 
 
In the model shown above, Compartment 1 represents plasma and Compartment 2 
represents an extra-plasma compartment. Thus, the “system” model, from the point of 
how the substance is metabolized in the body, is represented by these two compartments. 
Compartment 3 is the compartment into which the test substance, for example a drug, is 
administered. If the administration of the drug is oral, Compartment 3 can represent the 
first part of the gastrointestinal system. The Delay 4 represents passage and absorption of 
the drug through the gut. Since there is no loss from either Compartment 3 or Delay 4, it 
is assumed that the drug is completely absorbed (100% absorption). 
 
1. Start the SAAM II Compartmental application. The SAAM II Compartmental 

main window will open. 
 

2. Create the model. 
 
a. Create the following part of the model. 
 

 
 
b. Add the delay and transfer from the delay to Compartment 1. 
 

(1) In the SAAM II Toolbox, click Delay. 
 
(2) Click on the Drawing Canvas where you would like the delay to be 

located.  
 
(3) In the SAAM II Toolbox, click Flux 
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 (4) Click on Delay 3 and then Compartment 1; the transfer d(1,3) will be 
created. Your model will appear as follows: 

 

 
 

 Transfers from delays. Transfers from delays are denoted by “d(i,j)” instead of 
“k(i,j)”. The reason is that all material entering the delay eventually will leave 
the delay. Thus the d(i,j) represents a fraction of material moving along this 
pathway. In the model shown above, d(1,3) equals “1” because this is the only 
route by which material can leave the delay. If there were, for example, two 
routes by which material could leave the delay (as illustrated below in Part 2), 
the two d(i,j) would be numbers between 0 and 1, but the sum of the two 
would equal 1. An actual rate constant k(1,3) will be calculated internally by 
SAAM II; this value is available as output following a Solve or Fit. The value 
is the sum of the rate constants connecting the compartments in the chain 
representing the delay. 

 
 

c. Change the number of the delay from “3” to “4”. 
 

(1) Double-click Delay 3 to open the Delay Attributes dialog box. The dialog 
box will appear as follows: 
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(2) Change the Delay Number from “3” to “4”. 
 
(3) Click Done. Your model will appear as follows: 
 

 
 

d. Add Compartment 3 and transfer k(4,3) to your model. 
 
(1) In the SAAM II Toolbox, click Compartment. 
 
(2) Click on the Drawing Canvas where you would like Compartment 3 

located. 
 
(3) In the SAAM II Toolbox, click Flux. 
 
(4) Click on Compartment 3 and then Delay 4. The transfer k(4,3) will be 

added to your model which should appear as follows: 
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3. Create the experiment on the model. 
 

a. In the SAAM II Toolbox, click Experiment. The Experiment Attributes 
dialog box will open. 

 
b. Change the entry in the Units box from “minutes” to “hours”. 
 
c. Type “60” in the End At box. The Experiment Attributes dialog box will 

appear as follows: 
 

 
 
d. Click Done. The Create Experiment dialog box will open as shown below: 
 

 
 

Be sure Experiment is selected (as indicated by “Exper” in the New Name 
box). 

 
e. Click Create. Your model will appear as follows: 
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4. Add the data to the model 
 

a. On the Show menu, click Data, or alternatively, on the SAAM II Toolbar, 

click Data . The Data window will open. 
 
b. On the File menu, click Open. The file delay1.dat should appear in the list (if 

it does not, find the folder where you put this data file). 
 
c. Double-click delay1.dat. The data in this file will appear in the Data window 

as shown below: 
 

 
 
d. Close the Data window. 

 
5. Create the input and sample 
 

a. In the SAAM II Toolbox, click Input. 
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b. On the Drawing Canvas, click Compartment q3, and then click on the 

canvas. The input ex1 will appear associated with your model. 
 
c. Double-click ex1. The Exogenous Input dialog box will open.  
 
d. Type “400” in the Initial Amount box. 
 
e. Click Add. The Exogenous Input dialog box should appear as follows: 
 

 
 
f. Click Done. 
 
g. In the SAAM II Toolbox, click Sample. 
 
h. On the Drawing Canvas, click Compartment q1, and then click on the 

canvas. The sample s1 will appear associated with your model. 
 
i. On the Drawing Canvas, double-click s1 to open the Sample Attributes 

dialog box. 
 
j. Type “conc” in the Associate with Data Name box. 
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k. Edit the sample equation to read “s1=q1/Vc” in the Equation box. The 
Sample Attributes dialog box will appear as follows: 

 

 
 
l. Click Done. 
 

6. Enter the parameter values as shown below: 
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7. Work with the delay tool 
 

At this point, your model is specified except for information about the delay. 
Information about the delay is specified in the Delay Attributes dialog box which 
is accessible only in the Model mode. 
 
The Delay Attributes dialog box is shown below: 
 

 
 
The boxes in which information can be entered are: 

 
Delay Number: Here you can specify the number you want associated with the 

delay. 
 
Reference Name: You may add a reference name if you wish; this will appear 

associated with the delay in the same manner reference names appear with 
compartments. 

 
Delay Time: The delay time can be specified here numerically if you know the 

exact time of the delay. It can also be specified as a parameter. For example, if 
you changed “1.0000000” to “deltime”, deltime (delay time) would be 
interpreted by SAAM II as a parameter which would appear when you open 
the Parameters dialog box. 

 
Number of Compartments: You can specify the number of compartments in the 

delay. The more compartments in the delay, the “sharper” the delay, but the 
more time it will take to solve your model. 
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Fractional Distribution: When there is only one pathway leaving the delay, this 
box is dimmed. If there is more than one pathway leaving the delay, the 
fractional delay is active. As described in Part 2, you must specify the 
characteristics of the split delay if there is more than one pathway leaving the 
delay. 

 

 Technical information about delays. The delay represents a transfer function 
corresponding to a probability distribution; the distribution has a mean and 
variance (standard deviation). 

 
The mean is the delay time and the standard deviation is the delay width 
(measure of the sharpness of the delay). 
 
The transfer coefficient equals the number of compartments in the delay 
divided by the delay time. In the above example, this is “2” divided by “1” 
which equals “2”. Thus the transfer coefficient is reported as “2”  
 
The delay width equals the square root of the delay time divided by the 
transfer coefficient. In the above example, this is the square root of ½ which 
equals 0.70710678. 

 
 
a. Set the time of the delay equal to a parameter. 
 
 This tutorial will not work with delays where the exact time value is known. If 

this were the case, simply enter the time of the delay in the Delay Time box, 
and enter the number of compartments in the delay in the Number of 
compartments box. 

 
(1) In the SAAM II Toolbox, click Model to active these tools. 
 
(2) Double-click Delay 4 to open the Delay Attributes dialog box. 
 
(3) Change “1.0000000” to “tlag” in the Delay Time box. The Delay 

Attributes dialog box will appear as follows: 
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(4) Click Done. 
 

 The delay attributes dialog box. Remember the Delay Attributes dialog box 
can be opened only when you are in the Model mode. If you are in the 
Experiment mode and double-click on a delay, the following message will 
appear on the Drawing Canvas: 

 

 
 

Click OK, and return to the Model mode. 
 
 

 The delay time as a parameter. When you change the time of the delay from a 
number to a name, the name will appear as a parameter. In this case, tlag will 
appear when you open the Parameters dialog box. The time of a delay can be 
either a fixed or an adjustable parameter. 

 
 

b. Work with the delay time. 
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In this part of the tutorial, three simulations will be run using different times 
for the delay. Remember the number of compartments in the delay is set at the 
default value “2”. Each simulation will be saved, and a final plot comparing 
the three will be created. 
 
(1) In the Show menu, click Parameters, or alternatively, on the SAAM II 

Toolbar, click Parameters . The Parameters dialog box will open. 
 
(2) Double-click tlag to select it. Type “1” in the value box, and click Save. 

The Parameters dialog box will appear as follows: 
 

 
 
(3) Click Done. 
 
(4) In the Compute menu, click Computational Settings. The 

Computational Settings dialog box will open. In the Min. Nr. of 
Calculation Intervals box, change “20” to “200”. The Computational 
Settings dialog box will appear as follows: 
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Click Done. (Remember increasing the calculation intervals will give 
better resolution to the plots). 

 
(5) In the Compute menu, click Solve, or alternatively, on the SAAM II 

Toolbar, click Solve . 
 
(6) In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, 

click Plot . The Plot and Table Variables dialog box will open. Be 
sure the List All Variables check box is selected. 

 
(7) Click s1 to move this to the Current Selection pane. 
 
(8) Click Done. If the plot is not linear, in the View menu, click Semilog. The 

plot will appear as follows (the maximum for the Y Scale has been set 
equal to “12”) 
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(9) In the Compute menu click solutions. The Solutions dialog box will 

open. Click Add. The Solutions Variables dialog box will open. Scroll 
through the list, and select s1. The two dialog boxes will appear as 
follows: 
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Click Done. The Solutions dialog box will appear as follows: 
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Close the Solutions dialog box. 
 
(10) Set tlag equal to “10”. Set the Upper Limit for tlag equal to “50”. Repeat 

the above steps saving the solution as solution number “2”. The plot will 
appear as follows: 

 

 
 

Notice the peak is not as high as when the delay was equal to “1”. This is 
due to a combination of only two compartments in the delay, and the 
length of the delay time. 

 
(10) Set tlag equal to “20”, and repeat the above steps saving the solution as 

solution number “3”. The plot will appear as follows: 
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(11) Plot all three simulations simultaneously. With the plot window open, in 

the Set menu, click Plot/Tables Variables. The Plot and Table 
Variables dialog box will open. Be sure the List All Variables check 
box is selected. Select s1{1}, s1{2} and s1; the Plot and Table Variables 
dialog box will appear as follows: 
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Click Done. The plot will appear as follows: 
 

 
 

Close the Plot window. 
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 The delay time. For a given number of compartments in the delay, the longer 
the delay time, the less “pronounced” the delay will be. This is the result of 
the way the transfer between compartments in the delay is calculated.  

 
The transfer coefficient equals the number of compartments in the delay 
divided by the delay time. In the above example, this is “2” divided by “1”, 
“10” and “20” which equals “2”, “0.2” and “0.01” respectively. The material 
is slower passing through the delay as the delay time increases. 
 
The delay width equals the square root of the delay time divided by the 
transfer coefficient. This also increases as the delay time increases. 

 
c. Work with the number of compartments in the delay. 
 

In this part of the tutorial, the effect of the number of compartments in the 
delay will be investigated. Remember the number of compartments in the 
delay equals “2”. Leave all parameters as set previously; leave tlag equal to 
“20”. The Parameters dialog box should appear as follows: 
 

 
 

(1) In the Compute menu, click Solve, or alternatively, on the SAAM II 

Toolbar, click Solve . 
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(2) In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, 

click Plot . The Plot and Table Variables dialog box will open. Be 
sure the List All Variables check box is selected. 

 
(3) Click s1 to move this to the Current Selection pane. 
 
(4) Click Done. If the plot is not linear, in the View menu, click Semilog. The 

plot will appear as follows (remember the maximum for the Y Scale has 
been set equal to “12”) 

 

 
 
(5) In the Compute menu click solutions. The Solutions dialog box will 

open. Click Add. The Solutions Variables dialog box will open. Scroll 
through the list, and select s1. The two dialog boxes will appear as follows 
(remember you already have saved solutions – this will be solution “3”): 
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Click Done. The Solutions dialog box will appear as follows: 
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Close the Solutions dialog box. 
 
(7) In the SAAM II Toolbox, click Model to return to the Model mode.  
 
(8) Double-click Delay 4 to open the Delay Attributes dialog box. Change 

the number of compartments in the delay from “2” to “5”. The Delay 
Attributes dialog box will appear as follows: 

 

 
 

Click Done. 
 
(9) Solve the model and view the solution. The plot will appear as follows: 
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(10) Save s1 as solution “4”. 
 
(11) Set the number of compartments in the delay equal to “10”. Solve the 

model, view the solution, and save the solution as solution “5”. The plot 
will appear as follows: 
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(12) Repeat the previous step with the number of compartments in the delay 

set equal to “20”. The plot will appear as follows: 
 

 
 
(13) Compare all four simulations. With the Plot window open, in the Set 

menu, click Plot/Tables Variables. In the Plot and Table Variables 
dialog box, select s1{3}, s1{4}, s1{5} and s1. The Plot and Table 
Variables dialog box will appear as follows: 
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Click Done. The plot will appear as follows: 
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 The number of compartments in a delay. For a given delay time, the more 
compartments in the delay, the “sharper” the delay will become. This is the 
result of the way the transfer between compartments in the delay is calculated.  

 
The transfer coefficient equals the number of compartments in the delay 
divided by the delay time. In the above example, this is “2”, “5”, “10” and 
“20” divided by “20”. The material is faster passing through each 
compartment in the delay as the as the number of compartments increases. 

 
 
d. Solve the model, and fit the model to the data. 
 

(1) Set the value for tlag equal to “1” with a minimum and maximum 
respectively equal to “0.1” and “10”. 

 
(2) Set the number of compartments in the delay equal to “5”. 
 
(3) Solve the model, and view the solution. The plot will appear as follows 

(the Y Scale maximum has been set equal to “20”): 
 

 
 
(4) In the Compute menu, click Fit, or alternatively, on the SAAM II 

Toolbar click Fit . The plot will be updated as follows: 
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(5) View the details of the initial rise and fall. In the Set menu, click 

Plot/Table Scale. The Plot and Table Scale dialog box will open. Set the 
X Axis maximum equal to “5”. The Plot and Table Scale dialog box will 
appear as follows: 

 

 
 

Click Done. The plot will appear as follows: 
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You can see the effect of the delay in the initial portion of the curve. What 
is the effect of the number of compartments in the delay in this situation? 
If you increase the number of compartments to “20”, the plot will appear 
as follows: 
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The value for tlag is approximately 0.3, so you can see with the number of 
compartments equal to 20, the delay is approaching an absolute delay. 

 
(6) View the statistics. In the Show menu, click Statistics, or alternatively on 

the SAAM II Toolbar click Statistics . The Statistics window for the 
5 delay compartment model will appear as follows: 

 

 
 

The statistics for the model and data are satisfactory since the largest 
coefficient of variation is just under 25%. Notice, however, the derived 
variable k(1,4). There is no k(1,4) in the model; there is a d(1,4) for the 
delay. The value for k(1,4) is the value for the rate constants in the delay, 
and equal to the transfer rate constant from the last compartment in the 
delay to Compartment 1. 
 
It should be noted that the statistics will change a little if you change the 
number of compartments in the delay. The largest change will normally be 
in k(1,4) whose numerical value is a function of the number of 
compartments in the delay. 
 

8. Close all open windows and dialog boxes. 
 

Quit the SAAM II Compartmental application. You may save the study file if you 
wish. It is provided as part of this tutorial as delay1.stu. 
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 How many compartments in a delay. The number of compartments in a delay 
is an integer, and cannot be specified as an adjustable parameter. The number 
of compartments is set by the user, and can be determined by simulating 
which number provides the most reasonable description of the data. You need 
to be sure that the number of compartments in the delay does not have a 
substantial effect on the model parameters. For example, in the above if the 
number of compartments in the delay is set at “20”, the statistical information 
is: 

 

 
 

You can see there is essentially no difference except in the value of k(1,4) 
which, because the number of compartments is different, should be different. 
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Part 2. Working with the delay tool – Split output from the delay 
 
This part of the tutorial assumes you have worked through Part 1, and hence are familiar 
with the role of delay time and the number of compartments in the delay.  
 
In this part of the tutorial, you will create and work with the following model: 
 

 
In the model shown above, Compartments 1 and 2 represent two distinct plasma 
compartments of the test substance introduced into the system. Thus, the “system” model, 
from the point of how the substance is metabolized in the body, is represented by these 
two compartments. Compartment 3 is the compartment into which the test substance, for 
example a drug, is administered. If the administration of the drug is oral, Compartment 3 
can represent the first part of the gastrointestinal system. The Delay 4 represents passage 
and absorption of the drug through the gut. Since there is no loss from either 
Compartment 3 or Delay 4, it is assumed that the drug is completely absorbed (100% 
absorption). The two plasma compartments in this situation could be interpreted as a drug 
and a metabolite of the drug where conversion takes place during the absorptive process. 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental 
main window will open. 

 
2. Create the model shown above. 
 
3. Double-click Delay 4 to open the Delay Attributes dialog box. The Delay 

Attributes dialog box will open as follows: 
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Notice unlike the situation in Part 1, the Fractional Distribution check box is 
active. This is because there are two outputs from Delay 4. 

 
4. Set the delay attributes. 
 

a. Change the Delay Time from “1.000000” to “timelag”; timelag will become a 
model parameter. 

 
b. Change the Number of compartments from “2” to “10”. 
 
c. Click the Fractional Distribution check box. The Delay Fractional 

Distribution dialog box will open as shown below: 
 

 
 

Edit the equation “d(1,4) = 1.0-d(2,4)” to read “d(1,4) = frac”. Edit the 
equation “d(2,4)=d(1,4)” to read “d(2,4)=1-frac”. The Delay Fractional 
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Distribution dialog box and the Delay Attributes dialog box will appear as 
follows: 
 

 
 

d. Click Done in the Delay Fractional Distribution dialog box, and then click 
Done in the Delay Attributes dialog box. 

 

 Fractional distribution from a delay. When there is more than one loss from a 
delay, you must specify the fractional distribution along each loss pathway. It 
is essential to remember that the total fractional loss must equal 1. Thus when 
you specify the fractional distribution, you must be sure the total equals 1. In 
the situation here, d(2,4) is defined as a parameter frac; this parameter will 
appear in the Parameters dialog box. The equation “d(1,4) = 1.0 – d(2,4)” 
will define d(1,4) in such a way that “d(1,4) + d(2,4) = 1.” With two losses 
from a delay, making sure the sum of the fractional output equals “1” is easy; 
with more than two losses, it requires more bookkeeping. 

 
 

5. Create the experiment on the model. 
 

a. In the SAAM II Toolbox, click Experiment. The Experiment Attributes 
dialog box will open. 

 
b. Change the entry in the Units box from “minutes” to “hours”. 
 
c. Type “60” in the End At box. The Experiment Attributes dialog box will 

appear as follows: 
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d. Click Done. The Create Experiment dialog box will open as shown below: 
 

 
 

Be sure Experiment is selected (as indicated by “Exper” in the New Name 
box). 

 
e. Click Create.  

 
6. Add the data to the model 
 

a. On the Show menu, click Data, or alternatively, on the SAAM II Toolbar, 

click Data . The Data window will open. 
 
b. On the File menu, click Open. The file delay1.dat should appear in the list (if 

it does not, find the folder where you put this data file). 
 
c. Double-click delay1.dat. The data in this file will appear in the Data window 

as shown below: 
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d. Close the Data window. 

 
7. Create the input and sample 
 

a. In the SAAM II Toolbox, click Input. 
 
b. On the Drawing Canvas, click Compartment q3, and then click on the 

canvas. The input ex1 will appear associated with your model. 
 
c. Double-click ex1. The Exogenous Input dialog box will open.  
 
d. Type “400” in the Initial Amount box. 
 
e. Click Add. The Exogenous Input dialog box should appear as follows: 
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f. Click Done. 
 
g. In the SAAM II Toolbox, click Sample. 
 
h. On the Drawing Canvas, click Compartments q1 and q2, and then click on 

the canvas. The sample s1 will appear associated with your model. 
 
i. On the Drawing Canvas, double-click s1 to open the Sample Attributes 

dialog box. 
 
j. Type “conc” in the Associate with Data Name box. 
 
k. Edit the sample equation to read “s1=(q1+q2)/Vc” in the Equation box. The 

Sample Attributes dialog box will appear as follows: 
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l. Click Done. The model will appear as follows: 
 

 
 

8. Enter the parameter values as shown below: 
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It is important to notice the limits on the parameter frac; the value of this 
parameter cannot exceed “1”, nor be less than zero. 

 
9. Solve the model and view the solution. 
 

a. In the Compute menu, click Solve, or alternatively, on the SAAM II 

Toolbar, click Solve . 
 
b. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, 

click Plot . The Plot and Table Variables dialog box will open. Be sure 
the List All Variables check box is not selected. 

 
c. Click s1:conc to move this to the Current Selection pane. 
 
d. Click Done. If the plot is not linear, in the View menu, click Semilog. The 

plot will appear as follows:   
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10. Fit the model to the data, and view the solution. 
 

a. In the Compute menu, click Fit, or alternatively, on the SAAM II Toolbar 

click Fit . The plot will be updated as follows: 
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b. View the statistics. In the Show menu, click Statistics, or alternatively on the 

SAAM II Toolbar click Statistics . The Statistics window will appear as 
follows: 

 

 
 

To obtain this figure, you must scroll down thru the Parameter/Variable 
pane so that the derived variables are shown. The parameter d(1,4) equals 
frac; d(2,4) equals “1 – frac.” The rate constants k(1,4) and k(2,4) are the rate 
constants from the last compartment in the delay to Compartment 1 and 
Compartment 2 respectively. The sum of these rate constants equals the rate 
constant connecting the other compartments in the delay. 

 
11. Close all open windows and dialog boxes. 
 

Quit the SAAM II Compartmental application. You may save the study file is you 
wish. It is provided as part of this tutorial as delay2.stu. 
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Part 3. Specifying a delay using the Heaviside function 
 
 The Heaviside function 
 
The Heaviside function is: 
 

heaviside=0.5*(1.0+atan(lambda*(t - tlag))*2/3.141592653) 
 

In this expression, “atan” is the arctangent function. The expression “t – tlag” acts as a 
switch. For values of “t” less than “tlag” the value of the Heaviside function equals zero. 
For values of “t” greater than “tlag”, the value is non-zero. The values of the Heaviside 
function are between zero and 1. The parameter lambda controls the sharpness of the 
function, i.e. how close the values lie “exactly” between zero and 1. 
 
The following shows a series of simulations with lambda equal to “1” (s1{1}), “10” 
(s1{2}), “100” (s1{3}) and “1000” (s1).  
 

 
 
To see how the Heaviside function works, the following is the table of values when 
lambda equals 1000. 
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You can see up to time “5” the values of s1 are close to zero. After time “5”, they rise. 
This illustrates the essential point of the Heaviside function: it is continuous and 
differentiable! This is extremely important not so much for simulations (solving 
differential equations) but for fitting.  
 
Suppose delays could be implemented using a conditional expression “if-then-else”. The 
problem here is the conditional can introduce a discontinuity in the model solution. 
Problems can arise when there is a datum near the discontinuity during optimization since 
the algorithm for optimization does not know on which side of the discontinuity the 
datum lays. When using conditionals, one needs to be very careful that incorrect solutions 
are not returned. This is why conditionals (e.g. “if-then-else” or the FORTRAN functions 
AMIN and AMAX) are not implemented in the SAAM II Compartmental application. 
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In this part of the tutorial, you will create and work with the following model: 
 

 
 

The difference between this model and the model used in Part 1 is that the delay will be 
specified as part of the transfer k(1,3). 
 
 
 

1. Start the SAAM II Compartmental application. The SAAM II Compartmental 
main window will open. 

 
2. Create the model shown above. 
 
3. Create the experiment on the model. 
 

a. In the SAAM II Toolbox, click Experiment. The Experiment Attributes 
dialog box will open. 

 
b. Change the entry in the Units box from “minutes” to “hours”. 
 
c. Type “60” in the End At box. The Experiment Attributes dialog box will 

appear as follows: 
 

 
 
d. Click Done. The Create Experiment dialog box will open as shown below: 
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Be sure Experiment is selected (as indicated by “Exper” in the New Name 
box). 

 
e. Click Create.  

 
4. Add the data to the model 
 

a. On the Show menu, click Data, or alternatively, on the SAAM II Toolbar, 

click Data . The Data window will open. 
 
b. On the File menu, click Open. The file delay3.dat should appear in the list (if 

it does not, find the folder where you put this data file). 
 
c. Double-click delay3.dat. The data in this file will appear in the Data window 

as shown below: 
 

Rev. 11/01/05 DelaysUS-52 2004 - 2005 University of Washington 



Using SAAM II Using Delays 

 
 
d. Close the Data window. 

 
5. Create the input and sample 
 

a. In the SAAM II Toolbox, click Input. 
 
b. On the Drawing Canvas, click Compartment q3, and then click on the 

canvas. The input ex1 will appear associated with your model. 
 
c. Double-click ex1. The Exogenous Input dialog box will open.  
 
d. Type “400” in the Initial Amount box. 
 
e. Click Add. The Exogenous Input dialog box should appear as follows: 
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f. Click Done. 
 
g. In the SAAM II Toolbox, click Sample. 
 
h. On the Drawing Canvas, click Compartment q1, and then click on the 

canvas. The sample s1 will appear associated with your model. 
 
i. On the Drawing Canvas, double-click s1 to open the Sample Attributes 

dialog box. 
 
j. Type “conc” in the Associate with Data Name box. 
 
k. Edit the sample equation to read “s1=q1/Vc” in the Equation box. The 

Sample Attributes dialog box will appear as follows: 
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l. Click Done. The model will appear as follows: 
 

 
 

6. Specify the delay k(1,3). 
 

a. In the Show menu, click Equations, or alternatively, on the SAAM II 

Toolbar, click Equations . The Equations dialog box will open. 
 

b. Type the following equation in the Equations Defined Here box: 
 

heaviside=0.5*(1.0+atan(lambda*(t - tlag))*2/3.141592653) 
 

The Equations Defined Here pane in the Equations dialog box will appear 
as follows: 
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c. Close the Equations dialog box. 
 

 Using the Heaviside function. In the expression for the Heaviside function 
above, tlag will be an adjustable parameter which will equal the time of the 
delay. “t” is the name of the independent variable in the model. lambda is a 
parameter which will be hand tuned before fitting the model to the data. 

 
 
d. Double-click k(1,3) to open the Transfer Attributes dialog box. The 

Transfer Attributes dialog box will open. 
 
e. Type the equation “k(1,3)=ka*heaviside” in the Equation box. The Transfer 

Attributes dialog box will appear as follows: 
 

 
 

This expression will result in ka being defined as a parameter. 
 

f. Close the Transfer Attributes dialog box. 
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7. Enter the parameter values as shown below: 
 

 
 
8. Solve the model and view the solution. 
 

a. In the Compute menu, click Settings. The Computational Settings dialog 
box will open. Change the Min. Nr. of Calculation Intervals from “20” to 
“200”. This will improve the resolution of your plots. 

 
b. In the Compute menu, click Solve, or alternatively, on the SAAM II 

Toolbar, click Solve . 
 
c. In the Show menu, click Plot, or alternatively, on the SAAM II Toolbar, 

click Plot . The Plot and Table Variables dialog box will open. Be sure 
the List All Variables check box is not selected. 

 
d. Click s1:conc to move this to the Current Selection pane. 
 
e. Click Done. If the plot is not linear, in the View menu, click Semilog. The 

plot will appear as follows:   
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9. Fit the model to the data, and view the solution. 
 

a. In the Compute menu, click Fit, or alternatively, on the SAAM II Toolbar 

click Fit . The plot will be updated as follows: 
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b. View the first 5 minutes of the solution. 
 

(1) In the Compute menu, click Plot/Table Scale. The Plot and Table Scale 
dialog box will open. 

 
(2) In the X Axis pane, click Set. 
 
(3) Type “5” in the Maximum box. 
 
(4) Click Done. The plot will appear as follows: 
 

 
 
c. View the statistics. In the Show menu, click Statistics, or alternatively on the 

SAAM II Toolbar click Statistics . The Statistics window will appear as 
follows: 
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11. Close all open windows and dialog boxes. 
 
 

 lambda in  the Heaviside function. In the above, lambda was set equal to 100. 
The following plot compares the best fit of the model to the data with lambda 
equal to 10 (s1{1}), 100 (s1{2}) and 1000 (s1). 
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The details of the initial rise are shown as follows: 
 

 
 
You can see the differences in the initial rise caused by different values for 
lambda. 
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The statistics for the fit when lambda equal 10 and 1000 respectively are: 
 

 
 

 
 

You can see that, while the actual “Fits” are essentially the same, and the 
values for the Total objective function are essentially the same, there are 
differences in Vc and k(0,1). The reason for these differences is the fact that 
these parameters are highly correlated as shown in the statistics below for the 
case lambda equals 1000: 
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With a correlation coefficient for Vc and k(0,1) equal to -0.99 it is not 
surprising there are differences for these parameters for different values of 
lambda. However all lie within the calculated 95% confidence intervals. 
 
What is meant by “tuning lambda”? “Tuning lambda” is the process of 
adjusting lambda in increments until the model parameters become stable. 
Because of the nature of the Heaviside function, it is recommended tuning be 
done by increasing lambda by factors of 10 until the model parameters 
become stable (independent of the value of lambda). It is also recommended 
that in the fitting procedure the central difference formula be used for 
calculating the numerical derivatives. To set the central difference, in the 
Compute menu, click Settings. The Computational Settings dialog box will 
open. In the Derivative pane in the Optimizer pane, click Central. The 
Computational Settings dialog box will appear as follows: 
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The following shows the results of fitting the model to the data for different 
values of lambda: 
 
lambda 10 100 1000 10000 100000
Vc 3.774 4.247 4.298 4.298 4.298
k(0,1) 1.44 1.288 1.274 1.274 1.274  

 
You can see that for lambda equal to 1000 the parameters are stable. Thus in 
this tutorial a value of lambda equal to 1000 or 10000 would have been more 
appropriate than 100. If you wish, you can repeat this part of the tutorial using 
lambda equal to 10000 and carefully compare the results with the case lambda 
equals 100. 
 
When using the Heaviside function to create delays, you should go through 
the tuning process as described above to obtain an appropriate value of 
lambda for your particular modeling situation. 
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Quit the SAAM II Compartmental application. You may save the study file is you 
wish. It is provided as part of this tutorial as delay3.stu. 
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